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| had been considering for some time trying for my Extra Class ticket. So when | heard the club was
sponsoring an Extra Class online training | decided that now might be the time. After going through
several different books | can’t say one was better than other, no. It would depend on your learning
style. And having to pick just one would not be fair to the other two, all three were very good and I'm
sure almost anyone using any one of the three books would do fine when it came time for the test.

Of course the next consideration was all of the various online resources. Some are free, some require a
subscription. | looked briefly an a couple but decided that | would write my own. Why you might ask
when there is some much available online, a good question.

If any of you have been to my QRZ site you will find that | have written a lot of the software | use. The
key reason for that is to keep my brain from turning to mush. In my job before retiring | use to write a
lot of utilities that made my job easier and that allowed my project and program managers to be more
effective at managing their various projects. | found that writing programs as well as building some fairly
sophisticated Microsoft Excel tools was in some sort of twisted way, a form of relaxation for me, the way
crossword and Sudoku puzzles are for some people. After several months of retirement it was clear |
was starting to get soft in the brain. The other reason for writing my own program is | wanted to capture
all of the good tips and tricks for studying and passing the Extra Exam. | found that they were not all
included in one book or on one web site. | found that there was good information scattered across the
web and in many books and not just those specific to passing the Extra Class test.

After finishing the Extra Class program | decided to adapt it for the new hams studying for their
Technician class license. What you have is the result of months of work and a fair amount of testing.
But at the end of the day what this program is about is helping you to lean the concepts and make
passing the Technical class test easy.

A quick note on the manual: Throughout the figures are referencing the Extra Class test. The program
works exactly the same way as the extra class test so the differences are not important. The program
you are using is specific to the Technical Class Test.

The Feature Set

| knew the programming would be fairly easy and that the real work would be in developing what | call
the hints file or better yet the hints database. Following what in the software business we call the
Functional Requirements, or as | like to say, the feature set. Unlike other programs | have written in the
past where | made it up as | went, this time | had a very specific set of goals before writing a single line of
code. However | will admit to adding a couple of features toward the end of development cycle based
on feedback obtained during several Zoom sessions.

The Technician/Extra Class Training System Feature Set:



Give the user the ability to select a specific sub element to focus on. Why waste time on
modules already mastered?

Allow the user to go through the sub element questions in sequential order or in random order.
If the user selected sequential they could also specify which question they want to start with.
The thinking behind this was to make the program more useful in a multi student teaching
environment such as our weekly zoom sessions.

The answers were to be presented in a random order. This would require the user to know the
correct answer not just that it’s just always A,B,C or D.

Provide immediate feedback if the user missed a question during a drill. Upon missing a
guestions the question would be put back into the question pool. This would require the user to
ultimately answer the missed question correctly before ending the module.

Provide the user a way to see the answer, | call this the “Peek” feature. It displays the correct
answer A,B,C, or D but provides no explanation. | also wanted to be able to toggle this feature
on or off at the press of the space bar or a mouse click.

Allow the user to ask for a hint. The hint would provide an explanation of the concept and
provide the correct answer and if available a memory trigger or a simple way of remembering
the answer.

Give the user the ability to edit the hints database so they can add their own hints and memory
triggers.

Provides the user the ability to take a simulated practice test that looks and behaves exactly the
way the real test works with one exception.

The one exception is the way the “Review” function works. Like the real test when the user
selects “Review” the program displays a list of the question numbers and the users answer for
each of the questions. It also shows which questions have not been answered. My program
takes this one step further, it actually shows you what questions you have missed and your
current score based on the questions that have been answered.

The program must be able to display accompanying graphics given that some of the test
guestions are specific to certain graphics. This feature is also available in the practice test as
well as in the sub element drills.

In Study mode the user can review specific questions. This is handy if you are studying from and
book or in a classroom or group teaching setting. The teacher can enter in a specific question ID
and the question is displayed. Tapping any key displays the associated hint and tapping any key
again displays the correct answer.

The Program

Now that we have looked at the programs feature set let’s take a quick look at the program. Figure 1
shows the main menu. From this menu you can pick which sub element you wish to drill on or you can
select to take a practice test. You can use your mouse or the keyboard to select what you want to do.
You exit the program by clicking on the ‘X’ in the top right corner of the screen, as is customary for all
Windows programes.



If you choose to do a sub element module you will be asked if you want the questions presented in a
random order or in a sequential order. If you select [Rlandom you will go immediately into the drill.
Questions will be presented in a random order until you have answered all questions correctly or until
you select [Stop Drill]. Note that missed questions will be put back into the rotation and will be
presented again randomly during the drill.

If you selected to have the questions presented sequentially you will be asked which question you want
to start with, in most cases this will be question one. This feature was added after a couple of Zoom
sessions. It was clear that presenting the questions in order was necessary so attendees could follow
along more easily if they were running their own copy of the Extra Class Training System during the
training class or using one of the many study guides.
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Technician Cla Test Drills

Electrical Safety - [3 Exam Questions - 3 Groups]

FCC Rules [6 Exam Questions - 6 Groups]

Operating Procedures - [3 Exam Questions - 3 Groups]

Radio Wave Characteristics - [3 Exam Questions - 3 Groups]
Amateur Radio Practices - [2 Exam Questions - 2 Groups]
Electrical Principles - [4 Exam Questions - 4 Groups]
Electrical Components - [4 Exam Questions - 4 Groups]
Station Equipment - [4 Exam Questions - 4 Groups]
Modulation Modes - [4 Exam Questions - 4 Groups]

Antennas and Feed Lines - [2 Exam Questions - 2 Groups]

Take a Practice Test
Study Mode - review specific questions

Pick the sub element you want to practice (8-9, P, ?)

Figure 1: The Main Menu



Peek Feature: During a sub element session you can toggle the peek feature on or off by either tapping
the Space Bar or clicking to turn the peek feature on, or click on to turn the peek
feature off. With the peek feature enabled an “*’ will appear above the correct answer. In Figure 2 note
the “*” above the letter “D”.
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Question ID: T9A81 Module T9 - Antennas and Feed Lines

001. What is a beam antenna?
A. An antenna that reverses the phase of received signals
B. An antenna built from aluminum I-beams
C. An omnidirectional antenna invented by Clarence Beam

D. An antenna that concentrates signals in one direction
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Figure 2: Sub element Drill - Peek On

Hint Feature: During the drill if you find you need some help with a question you can ask for a hint by
clicking on “Hint” or pressing the “H” key. Refer to Figure 3. For this particular question not only is an
explanation given but also a clever hint, “Very high Fry-ability.”
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Question ID: EQA@G3 C Module: E@ - SAFETY [11 Questions]

001. Over what range of frequencies are the FCC human body RF exposure limits most
restrictive?

A. 300 kHz to 3 MHz
B. 300 to 3000 MHz
C. 30 to 300 MHz

D. 3 to 30 MHz

1 A 01 8 i ¢ Ji{ 0 Jistop Drillf Run Time: 00:22:38 Hint

The Correct Answer is: C

[See page 11-4] As the graph of Maximum Permissible Exposure (MPE) shows, the lowest allowable
levels are from 30 to 300 MHz, rising slightly above 300 MHz. Shorter wavelength RF energy is
more readily absorbed by the body, particularly when the body part, such as an arm or head, is
of comparable size to the wavelength. The range of frequencies over which the FCC human body
exposure limits are the most restrictive are 30 - 300 MHz. Hint: VHF is the most dangerous.
Very High Fry-ability.

Figure 3: Sub Element Drill showing the hint.

Practice Test: The other feature of the program is the practice test. Refer to Figure 4. The practice test
has been designed to act and feel the same as the real test. Questions are selected at random from
each sub element, with one question coming from each sub group. The questions are presented in
random order and the answers are also presented in a random order. In short no two tests should ever
be alike. Refer to Figure 4.

And like the real test you can skip a question and go back to a question at any time. However the review
feature behaves a little differently than the real test.
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1. Which of the following represents an inductive reactance in polar coordinates?
A. A negative magnitude
B. A negative phase angle
C. A positive magnitude

D. A positive phase angle
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Figure 4: The Practice Test

The Practice Test, the Review Feature: Please refer now to Figure 5. Given this system was intended to
be a training tool it was necessary that it provide some level of feedback. To that end the review feature
works a little differently than the real test. To begin you can toggle the review feature on or off. You
can leave it on during the test so as to show you every time you miss or correctly answer a question. Or
you can toggle it off and only review your status when you feel it beneficial to do so. Simply toggle it on
or off by clicking on the review button or pressing “R”.

The Review feature will show you the questions you have missed in red and show you your score based
on the questions that you have answered, see Figure 5. In referring to Figure 5 | have clearly not done



very well on this practice test, | answered 40 questions and only got 10 correct for a failing score of 25%
on the questions that | actually answered. Questions that were not answered are blank so before
ending the test one should go back to the unanswered questions and complete them. In the real test,
missed questions are not deducted from the total of 50 questions. Your actual score in the real test is
based in the number of correct answers out of a possible 50 questions. A skipped question is the same
as an incorrect answer in the real test.

Finally you can of course end the test at any time by selecting Stop Exam. Note also that when you have
answered all 50 questions the program will inform you and then let you decided if you want to review
and possibly change some of you answers or revisit any questions you might have skipped over or simply
stop the test and get your final score.
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46. What is resonance in an LC or RLC circuit? ‘
A. The lowest frequency that will pass current
B. The highest frequency that will pass current
C. The frequency at which the reactive impedance equals the resistive impedance

D. The frequency at which the capacitive reactance equals the inductive reactance

A B[ C][D] Next Prev Review Stop Exam

Correct Answers: 19 1. D 11, D 21. B 31. A 41, C
Incorrect Answers: 30 92. C 12. C 22. A 32. B 42. B
Your Score: 25 X 3. 8 13. B 23, 33. D 4. A
| Test Status: Fail e4. A 14. A 4. 0 34. 44 B
05. A 15. B 2. € 35. C 45. €

06. B 16. C 26. D 36. B a6.

07. C 17. C 7% '€ 37. C a7.

@8. D 18. 28. 38. as.

09, C 19. D 29. B 39. D a9,

19. D 20. C 30. A 4. D 50.

Figure 5: The Practice Test - The Review Feature

Overall the program is pretty simple to operate, the goal after all, was to study and get ready for your
exam and not waste a minute figuring out how to use the program.



Customizing the Hint’s Database

One of what | think is one of the most important features of the program is the ability to add your own
hints and graphics to the hints database. Although the program comes with a fairly robust set of hints
and graphics you can also add your own or add your own embellishment to the existing hints. This
section will explain how to include your own hints and graphics.

To begin the hints database is nothing more than a text file which means it can be edited using a
common text editor such as Windows Notepad or a more feature rich text editor such as Notepad++.
You should not use a program like Microsoft Word, however if you do, make sure you save the file as a

DOS text file.

You will find the hints.txt file in the directory where you installed the program. Let’s begin by opening
the file and examining a typical line. The each line has a fairly specific format:

Hint ID: [Page Reference] followed by that hint text, refer to Figure 6. The hint ID is the question
reference number used in the Big Green Book. The Hint ID format is ‘E’ for Extra, the Sub element
number, followed by the sub element group ID, and finally the question number in the group, example
the Question ID for E1A01 would be specific to a question from the Extra Class question pool, from sub
element 1 on Commission Rules, and from group A which is about Operating Standards in regard to
frequency privileges and specifically question 1 about legal carrier frequencies. See page 13-4 in the Big
Green Book. Note that the page reference included in the provided hints database is specific to the Big
Green Book. You can however include not only the page reference between the brackets but a book
reference as well, example: [ARRL Antenna Handbook, 24™ Edition, page 21-4]

A hint cannot be on more than one line and cannot be more than 1425 characters in total length. You

do not need to put a blank line between hints. In the example below the blank lines were added only to
make the file more readable. If there is a graphic associated with the hint the reference will be placed at
the very end of the line and will be in the form of: ~Figure EIA01.bmp In this example the actual graphic
is named E1AO01.bmp and is located in the “Figures” sub folder under the main installation folder. All
graphic files must be in a bit map format, aka: a .bmp file.

As long as you follow the prescribe format you can add as many hints as you like. However, only one
hint per question. You are also welcome to edit the hints file and add whatever hints you have found
useful. | also encourage you to send any hints you might want added to me for inclusion in future
updates to the hints database.



""" | Hints.txt - Notepad B . 8

File Edit Format View Help
EOAQ1: [See page 11-8] The earth connection is primarily to stabilize power system voltage during lightning strikes. All earth connections in a home anc »

E0A02: [See page 11-5] Because you do not control when your neighbor may be at home, the exposure is considered uncontrolled. When performing
EOAO03: [See page 114] As the graph of Maximum Permissible Exposure (MPE) shows, the lowest allowable levels are from 30 to 300 MHz, rising sligt
E0A04: [See page 11-7] In multi-transmitter sites, such as hilltop facilities where there may be commercial facilities along with amateur repeaters, precise
EOAO05: [See page 11-7] Because the wavelength of microwaves is a few centimeters or less, it is relatively straightforward to construct antennas with ga
EQA06: [See page 11-3] In the far field of antennas, exposure from the E and H fields can be combined into a composite power density. Near the anteni
EOAO7: [See page 11-2] Since carbon monoxide (CO) is odorless and colorless, the only way to detect it is with a carbon monoxide detector. Similar tc
E0A08: [See page 114] Specific Absorption Rate (SAR) measures the rate at which energy from an electromagnetic field is absorbed by the human bo
E0AQ09: [See page 11-2] Beryllium oxide (BeO or beryllia) is a white ceramic insulator that has the unusual property of also being an excellent thermal cc
EOA10: [See page 11-2] Polychlorinbated biphenyls (PCBs) were once commonly added to insulating oils to improve their stability and insulating qualiti ,

< >
Ln 25, Col 493 100%  Windows (CRLF) UTF-8

Figure 6: The Hints.txt file

Installation

The program is pretty easy to install. To give you a thumbnail of the process, after downloading it from
the OARC web site, unzip the file and run the setup utility and then modify the shortcut. The steps
below will walk you through the process in a bit more detail. If you have any issues please drop me a
note and | will be happy to help you. Before beginning the installation the program let’s make sure you
have the right hardware and operating system.

Program Requirements:

Required: A computer running Windows. This program was developed using Windows 10 but there’s no
reason it shouldn’t run under Windows 7 or even Windows XP.

Required: Disc space and memory requirements are minimal, just under 85 Mb of disk space. In terms
of memory the program is fairly small, the memory foot print is around 4Mb and CPU utilization is under
.5%. Soin terms of computer resources the requirements are minimal.

Required: A desire to learn and the time necessary to practice.

Installation Instructions:

v" Download the program from the OARC web site. It should be located in the down load area on the



OARC web site see: http://ogdenarc.org/downloads.html. If a class is being offered a link will be
provided on the OARC home page just under the link to the Zoom meeting invite. It can also be found
under Member downloads by Eugene Morgan. After you have downloaded the file unzip it and run the
TechSetup.exe. If you are reading this article make sure you also do the next two steps.

v" The next step requires that we configure the Extra Class Training System window size. On your
desktop you will find the “Tech Test” icon. Right Click on it and select Properties. In the properties
window you will see a number of tabs, click on the Layout tab. In the middle of the Layout Tab
window you will see a box labeled Windows Size. Set the Width: to 100 and the Height: to 43.

v" While you have the shortcut open next select the [Options] tab. Uncheck the [Quick Edit Mode)
option. Then click on the [Ok] button. At this point you can run the Extra Class Practice program.

Just In Case You See A Warning From Windows Defender or other Anti-Virus program: When
executing or installing the program for the first time you may experience a warning from Microsoft
Defender or your anti-virus software warning you about this program. Don't worry. In the case of
Microsoft Defender just click on the "More info" link then click on the "Run anyway" link. This only
occurs the very first time the program is launched and only on some computers. | take extreme
precautions to make sure that none of my programs are infected and scan each before sending on to the
clubs Web Master.
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testing. Justin Hall (KP7LAK) for feedback, the loan of the Craig Buck book complete with highlights and
notations as well as beta testing the various versions. | would also like to thank Rick Morrison (W7RIK)
for some help explaining what the real test looks like, beta testing and providing feedback. | also need
to send a thank you to Pete Heisig (AI7GV) for loaning me his copy of the little green book, which was
well mark and truly broke in as well. Pete also shared with me his memory of the test screens. | can’t
express my thanks and appreciation to these three enough. Their testing, their input, and their recall of
the test itself was a big help in getting the program to its final state. A heartfelt thanks Guys!

Future Plans and Possible Updates: | will continue to refine and update the hints database over time
and have arrange with the clubs Web master to post these updates in the future. | will also send out
updates to the hints file for those who | know are using the program. Once | complete the Extra Class
Training System | will also provide a version for the Tech class and the general class courses. | hope to
have them ready for the next round of testing in the fall if not sooner.

In Closing: | know there are a lot of good resources out there in the form several books, many not
mentioned here, as well as a host of web sites. Regardless, | hope you will find my program just as
helpful if not more so. If you decided to use my program then please accept my sincere thanks.

If you have any questions or if you have some ideas about additional features or improvements give me
a call. If you find any bugs please do contact me with the specifics. If you are interested in seeing the
source code or doing a deep dive into the code drop by, | love talking about this stuff. Above all and
most importantly to me, | hope you enjoy using my program.
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